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[bookmark: _Toc501024591]The disasters that are likely to affect our household are:
	[bookmark: Check1]|_| Tornado
	|_| Severe Storms
	|_| Ice Storm
	|_| Flash Flood
	|_| River Flooding

	|_|Wildfires
	|_| Earthquake
	|_| Winter Storm
	|_| Heatwave
	|_| Drought

	|_| Pandemic (flu)
	|_| Sinkhole
	|_| House Fire
	|_|      
	|_|      



[bookmark: _Toc501024592]Evacuations / Travel Plans
What are the escape routes from our home? (know at least 2 ways to get out of your neighborhood)
	1
	     

	2
	     

	3
	     



 If separated during an emergency, what is our meeting place in our neighborhood?
	     



If we cannot return home or are asked to evacuate, what is our meeting place outside of our neighborhood?
	     



If we have to leave the house because it is unsafe (fire, collapse, smoke, etc.) our meeting place near the house is?
	     



[bookmark: _Toc501024593] Emergency Contacts
Main Out of the Area Contact
	Name
	Home Phone
	Cell Phone
	Email
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Alternate Out of the Area Contact:
	Name
	Home Phone
	Cell Phone
	Email

	     
	     
	     
	     



[bookmark: _Toc501024594]If at school/daycare, our children will be evacuated to:   
	Child’s Name
	Evacuation Site
	Pickup Procedure

	     
	     
	     

	     
	     
	     

	     
	     
	     

	     
	     
	     



[bookmark: _Toc501024595]Nearest Tornado Safe Rooms
	Name of Facility
	Address
	Minutes from our house
	Do they accept pets?

	     
	     
	     
	

	     
	     
	     
	


[bookmark: _Toc501024596]
Our plan for people in our household with a disability or special need is:
(include person responsible, any special medications or equipment needed, etc.)
	Person’s Name
	Plan

	     
	     

	Medical Equipment Needed
	     

	Medications Needed
	     

	Location of Medications
	     



	Person’s Name
	Plan

	     
	     

	Medical Equipment Needed
	     

	Medications Needed
	     

	Location of Medications
	     



	Person’s Name
	Plan

	     
	     

	Medical Equipment Needed
	     

	Medications Needed
	     

	Location of Medications
	     


[bookmark: _Toc501024597]Pre-Disaster Activities
[bookmark: _Toc501024598]Family Member Responsibilities:
	Task
	Description
	Family Member Responsible

	Home Disaster Kit
	Stock the disaster kit and make sure it is up to date. See recommended list below.
	     

	Evacuation Kit
	Stock the Evacuation kit and make sure it is accessible and ready to go at a moments notice.  Include items you might want to take to an evacuation shelter. See recommended list below.
	     

	First Aid Kit
	Stock the First Aid kit and make sure it is up to date. See recommended list below.
	     

	Pet Evacuation Kit
	Stock the pet evacuation kit and make sure it is up to date. Be sure to include pet supplies in your Home Disaster Kit also. See recommended list below.
	     

	Vehicle Emergency Kit
	Stock the Vehicle Emergency Kit and make sure it is up to date and in the vehicle at all times. See recommended list below
	

	Information Access
	Make sure that the NOAA Radio is programmed and has fresh batteries. Ensure that all family members have an up to date copy of this plan. Make sure all members have at least 2 ways to get emergency notifications (Swift 911 App, local media alert apps, etc). Make sure there is a battery powered radio both disaster kits. Make sure every family member has a copy of this plan.
	     

	Family Medical / Medicine Information
	Keep current lists of family members medications and medical information. Make sure these lists are in the evacuation kit. Include medication list, doctors contact info, medical alerts and any allergic reaction information. See template below.
	     

	Financial Information
	Obtain copies of bank statements and keep some cash in the disaster kits in the event ATMs and credit cards do not work due to power outages.  Bring copies of utility bills as proof of residence in applying for assistance from Red Cross or FEMA.
	     

	Pet Information
	Keep a phone list of pet‐friendly motels and animal shelters and Vets and keep in the pet disaster kit.
	     

	Information Notebook
	Include a 3-ring binder to your kit to store reference material in. Include: how to purify water, first aid instructions, NOAA radio frequencies, pet first aid, etc. Keep an electronic copy as well as important documents on a jump drive stored in the disaster kit.
	     

	Smoke, Carbon Monoxide Detectors, Fire Extinguishers
	Check each piece of equipment monthly to ensure proper operation, check and replace batteries as needed. Have the fire extinguishers tested annually. 
	     

	Generator
	Check and start the generator monthly to ensure proper operation. Check oil level, filters and fuel supply. Refer to manufacturers recommendations on long term fuel storage in the fuel tank. 
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[bookmark: _Home_Disaster_Kit][bookmark: _Toc501024599]Home Disaster Kit Contents:
	|_|
	Water, Stored in Gal Jugs for cleaning, sanitation, food prep (1 gal per person per day) 4 days preferred)
	|_|
	Water, smaller bottles for drinking (1 gal per person per day)

	|_|
	Food (at least a four-day supply of non-perishable food)
	|_|
	Garbage Bags

	|_|
	Battery-powered or hand crank radio
	|_|
	Basic tools (hammer, screwdrivers, pliers, wrench, crowbar)

	|_|
	NOAA Weather Radio
	|_|
	Tool to turn of utilities: gas, water

	|_|
	Flashlight with spare batteries
	|_|
	Manual can opener

	|_|
	First Aid Kit
	|_|
	Local Paper Maps

	|_|
	Whistle
	|_|
	Solar powered cell phone charger

	|_|
	Phone Chargers
	|_|
	Duct Tape

	|_|
	N-95 Dust Masks
	|_|
	Toilet paper

	|_|
	Family Medical / Medicine List
	|_|
	Baby / Small Children’s Supplies (formula, toys, etc)

	|_|
	Financial Information
	|_|
	Blankets

	|_|
	Pet Information
	|_|
	Change of Clothes

	|_|
	Medications
	|_|
	Moist towelettes

	|_|
	Cash
	|_|
	Feminine Supplies

	|_|
	Paper and Pencil
	|_|
	Rain Poncho’s

	|_|
	Chlorine Bleach (purify water)
	|_|
	Medicine Dropper (measure bleach for water)

	|_|
	Information Notebook
	|_|
	Spare reading glasses

	|_|
	Contact lenses and solutions
	|_|
	Pet Food

	|_|
	Mess Kit (paper plates, utensils, paper towels, etc)
	|_|
	Vitamins

	|_|
	Knife
	|_|
	Multi-Tool

	|_|
	Leather Work Gloves
	|_|
	Winter Clothes (gloves, knit hat, etc.)

	|_|
	Roll of Plastic Sheeting
	|_|
	Hand Sanitizer

	|_|
	Pepper Spray
	|_|
	Candles

	|_|
	
	|_|
	Fire starter (matches, lighter, etc)

	|_|
	
	|_|
	

	|_|
	
	|_|
	

	Optional Items

	|_|
	Lantern
	|_|
	Tarps

	|_|
	Two Way Radios (FRS Radios)
	|_|
	Books, Games, Puzzles

	|_|
	Small Cooking Stove with Fuel
	|_|
	Utility Rope

	|_|
	Sleeping Bags
	|_|
	Paracord

	|_|
	Light Sticks
	|_|
	Fire Starter (matches, lighters, etc)

	|_|
	ZipLoc Bags
	|_|
	Bandana’s

	|_|
	Super Glue
	|_|
	Water Purification Tablets

	|_|
	Hatchet
	|_|
	Chainsaw

	|_|
	Small Water Filter
	|_|
	Extra Firewood

	|_|
	     
	|_|
	     

	|_|
	     
	|_|
	     

	|_|
	     
	|_|
	     

	|_|
	     
	|_|
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[bookmark: _First_Aid_Kit_1][bookmark: _Toc501024600]First Aid Kit Contents:
	|_|
	2-inch sterile gauze pads (12+)
	|_|
	Tweezers

	|_|
	4-inch sterile gauze pads (12+)
	|_|
	Needle

	|_|
	Hypoallergenic adhesive tape (2)
	|_|
	Moistened towelettes

	|_|
	Triangular bandages (3)
	|_|
	Antiseptic

	|_|
	2-inch sterile roller bandages (6+ rolls)
	|_|
	Thermometer

	|_|
	3-inch sterile roller bandages (6+ rolls)
	|_|
	Ice Packs

	|_|
	Scissors
	|_|
	Tube of petroleum jelly or other lubricant

	|_|
	Assorted sizes of safety pins
	|_|
	Latex gloves (2 pair)

	|_|
	Cleansing agent/soap
	|_|
	Sunscreen

	|_|
	Hydrocortisone
	|_|
	Bug Spray

	|_|
	Ibuprofen / Tylenol
	|_|
	Calamine Lotion

	|_|
	Benadryl
	|_|
	Neosporin

	|_|
	Antacids
	|_|
	Saline Solution

	|_|
	Baby Wipes
	|_|
	Large Trauma Pads (6+)

	|_|
	Q-Tips
	|_|
	Emergency Blankets

	|_|
	Imodium / Pepto-Bismol
	|_|
	     

	|_|
	     
	|_|
	     

	|_|
	     
	|_|
	     

	|_|
	     
	|_|
	     

	|_|
	     
	|_|
	     



[bookmark: _Evacuation_Kit_Contents:][bookmark: _Toc501024601]Evacuation Kit Contents: (to go to a Long-Term Shelter, consider a kit for each family member)
	|_|
	Map marked with at least two evacuation routes
	|_|
	Change of clothing

	|_|
	Prescriptions or special medications
	|_|
	Extra eyeglasses or contact lenses

	|_|
	An extra set of car keys, credit cards, cash
	|_|
	First aid kit

	|_|
	Flashlight
	|_|
	Battery-powered radio and extra batteries

	|_|
	Toilet Paper
	|_|
	Copies of important documents (birth certificates, passports, License, SS # etc.)

	|_|
	Pet Disaster Kit
	|_|
	Personal computer information on a jump drive

	|_|
	Chargers for cell phones, laptops, etc.
	|_|
	Personal Care Items: tooth brush, deodorant, etc.

	|_|
	Baby / Small Children’s Supplies (formula, toys, etc)
	|_|
	Family Medical / Medicine List

	|_|
	NOAA Weather Radio
	|_|
	Financial Information

	|_|
	Paper and Pencil
	|_|
	Feminine Supplies

	|_|
	Any special dietary needs or food
	|_|
	Any Special Medical Equipment/extra batteries

	|_|
	Emergency Contact Lists
	|_|
	Bedding (sleeping bags or warm blankets)

	|_|
	               Who is responsible for grabbing the kit?
	|_|
	     

	|_|
	     
	|_|
	     

	|_|
	     
	|_|
	     

	|_|
	     
	|_| 
	     





[bookmark: _Pet_Evacuation_Kit][bookmark: _Toc501024602]Pet Evacuation Kit
	|_|
	Food (at least 4 days’ supply)
	|_|
	Water (at least 4 days’ supply)

	|_|
	Medications
	|_|
	Medical records

	|_|
	Cat Litter Box, Litter, Litter Scoop
	|_|
	Garbage Bags (collect pet waste)

	|_|
	Leash / Harness
	|_|
	Pet Carrier

	|_|
	Current Photo’s / Descriptions of pets
	|_|
	Vet Contact info

	|_|
	Grooming Items
	|_|
	Bleach

	|_|
	Paper Towels
	|_|
	Micro Chip Information

	|_|
	Food and Water Dishes
	|_|
	Flea and tick medication

	|_|
	Toys
	|_|
	Pet First Aid Book

	|_|
	Pet First Aid Kit
	|_|
	Latex Gloves

	|_|
	Treats
	|_|
	Bedding

	|_|
	     
	|_|
	     

	|_|
	     
	|_|
	     



[bookmark: _Vehicle_Emergency_Kit][bookmark: _Toc501024603]Vehicle Emergency Kit
	|_|
	Jumper cables
	|_|
	Flares or reflective triangle

	|_|
	Ice Scraper
	|_|
	Cell Phone Charger

	|_|
	Cat Litter or Sand for traction
	|_|
	Can of Ice Melt for door locks and handles

	|_|
	Blanket
	|_|
	Warm clothes, stocking cap, winter boots, gloves

	|_|
	Small First Aid Kit
	|_|
	Fire Extinguisher

	|_|
	Tire Gauge
	|_|
	Foam Tire Sealant

	|_|
	Flashlight and extra batteries
	|_|
	Duct Tape

	|_|
	Drinking water
	|_|
	Snacks

	|_|
	     
	|_|
	     

	|_|
	     
	|_|
	     

	|_|
	     
	|_|
	     



[bookmark: _Information_Notebook_Contents][bookmark: _Toc501024604]Information Notebook Contents
	|_|
	A copy of this plan
	|_|
	Insurance information

	|_|
	Info on how to sanitize water
	|_|
	Informational Web Sites

	|_|
	First Aid Manuals
	|_|
	Copies of titles, registrations

	|_|
	Bank Account Information
	|_|
	Identification / Driver’s License / SS#

	|_|
	Immunization records
	|_|
	Birth Certificates

	|_|
	Maps of the area
	|_|
	Pet‐friendly motels and animal shelters

	|_|
	Names and addresses of close relatives
	|_|
	     

	|_|
	     
	|_|
	     

	|_|
	     
	|_|
	     

	|_|
	     
	|_|
	     

	|_|
	     
	|_|
	     




[bookmark: _Family_Medicine_Information][bookmark: _Toc501024605][image: ]Family Medicine Information
	Name
	Medication
	When Med is taken
	Doctor
	4-day supply in Disaster Kit?

	     
	     
	     
	     
	

	     
	     
	     
	     
	

	     
	     
	     
	     
	

	     
	     
	     
	     
	

	     
	     
	     
	     
	

	     
	     
	     
	     
	

	     
	     
	     
	     
	

	     
	     
	     
	     
	

	     
	     
	     
	     
	

	     
	     
	     
	     
	



Family Medical Information
	Name
	Age
	Medical Issue
	Doctor
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[bookmark: _Toc501024606]Preparedness Activities
	[bookmark: _Toc501024607]General Preparedness Activities

	|_|
	Does everyone have a copy of this plan?
	|_|
	Have we practiced our Evacuation Drill?

	|_|
	Have we practiced our Fire Drill?
	|_|
	Does everyone know how to use 911?

	|_|
	Do we have adequate Insurance Coverage? Do we need Flood Insurance?
	|_|
	Do we have smoke detectors installed?

	|_|
	Do we know how to shut the power off if needed?
	|_|
	Have we checked the batteries in the smoke detectors and tested them monthly

	|_|
	We have a working carbon monoxide detector?
	|_|
	

	|_|
	Chemicals stored out of reach of children
	|_|
	Tall, heavy furniture secured to wall?

	|_|
	Do we know how to shut off the gas and water to our house?
	|_|
	Is our water heater strapped to the wall to prevent tip over?

	|_|
	Do we have Carbon Monoxide Detectors installed?
	|_|
	     

	|_|
	     
	|_|
	     

	|_|
	     
	|_|
	     

	|_|
	     
	|_|
	     

	[bookmark: _Toc501024608]Fire Safety Preparedness

	|_|
	Do we have fire extinguishers? ABC type
	|_|
	Flammable liquids stored properly?

	|_|
	Fire Extinguishers up to date and working?
	|_|
	Have we replaced frayed or cracked extension and appliance cords?

	|_|
	Does everyone know where to meet outside if we have a fire and have to get out?
	|_|
	Are our important papers and valuables stored in a
fire-proof safe or cabinet?

	|_|
	Everyone has two ways out of the house in case of a fire?
	|_|
	Combustible materials are not stored near the furnace, hot water heater or space heaters?

	|_|
	Our chimney / flue pipes have been cleaned and checked?
	|_|
	Utility shut off tools are stored in an accessible location?

	|_|
	Is our house number clearly visible outside?
	|_|
	     

	|_|
	     
	|_|
	     

	|_|
	     
	|_|
	     

	|_|
	     
	|_|
	     

	[bookmark: _Toc501024609]Tornado Preparedness

	|_|
	Do we know where to go inside the house in the event of a tornado?
	|_|
	Can we stay in the house if there is a tornado, or do we go to the nearest Safe Room?

	|_|
	If we have to go to a Safe Room tornado shelter, do we have a “kit” prepared to take with us?  Toys, baby needs, water, radio, phone charger, etc. 
	|_|
	If we have to go to the nearest Safe Room, have we practiced getting there and know how long it will take. 

	|_|
	Do we know the opening procedures for the Safe Room that we will be going to?
	|_|
	Do we have a NOAA weather alert radio in the home?  Have we checked it monthly?

	|_|
	Does everyone in the family have a way to receive weather alerts and warnings?
	|_|
	Does everyone in the home know the difference between watches and warning issued by NOAA?

	|_|
	Have we practiced our “in home” tornado drill?
	|_|
	Does someone in the family watch the weather forecast daily?

	|_|
	Is our disaster kit stored near the tornado shelter in our home?
	|_|
	Is there a battery powered radio in our tornado shelter location?

	|_|
	     
	|_|
	     

	|_|
	     
	|_|
	     

	|_|
	     
	|_|
	     

	[bookmark: _Toc501024610]Winter Weather / Ice Storm Preparedness

	|_|
	Our home is well insulated and we have weather stripping around our doors and windows
	|_|
	Do we have a working carbon monoxide detector?

	|_|
	Our vehicles are winterized and always have more than a half tank of gas?
	|_|
	Our vehicles have an emergency kit?

	|_|
	Are tree limbs trimmed away from our house / power lines?
	|_|
	Do we add extra food items to our disaster kit in the winter in case we loose power for several days?

	|_|
	Do we have plenty of batteries on hand in case we loose power for several days?
	|_|
	Do we have an alternate lighting source?  Solar lights, candles, lanterns, etc. 

	|_|
	Do we have shovels for snow removal?
	|_|
	Do we have extra bags of Ice Melt?

	|_|
	Do we have an emergency heat source?
	|_|
	Do we have a way to cook without electricity?

	|_|
	     
	|_|
	     

	|_|
	     
	|_|
	     

	|_|
	     
	|_|
	     

	|_|
	     
	|_|
	     

	[bookmark: _Toc501024611]Severe Weather / Thunderstorm Preparedness

	|_|
	We removed dead or rotting trees and branches that could fall and cause injury or damage
	|_|
	Outdoor objects are secured that could blow away or cause damage.

	|_|
	Everyone knows the difference between “Watch and Warnings” issued by NOAA
	|_|
	We have a NOAA weather radio.

	|_|
	Everyone has at least 2 ways to receive alerts?
	|_|
	Everyone knows to stay away from windows during the storm and to stay indoors?

	|_|
	     
	|_|
	     

	|_|
	     
	|_|
	     

	|_|
	     
	|_|
	     

	|_|
	     
	|_|
	     

	[bookmark: _Toc501024612]Flood / Flash Flood Preparedness

	|_|
	Do we need to purchase Flood Insurance?
	|_|
	Have we checked with local officials / neighbors to see if our property is prone to flooding?

	|_|
	Everyone in the family knows not to drive thru flooded roadways?
	|_|
	If our property is prone to flooding, do we have a plan to elevate important items, unplug electrical appliances before water comes into the house?

	|_|
	Are the roads to our house prone to flooding/
	|_|
	If the roads are impassable, do we have a different way to get home, or someplace to stay until it is safe to return home?

	|_|
	Are our important papers kept in a water proof container?
	|_|
	Are there things we can do to reduce flooding potential?  Berms, ditches, culverts, etc?

	|_|
	     
	|_|
	     

	|_|
	     
	|_|
	     

	|_|
	     
	|_|
	     

	|_|
	     
	|_|
	     







	[bookmark: _Toc501024613]Power Outage Preparedness

	|_|
	Do we have coolers on hand to keep food from spoiling?
	|_|
	Do we have 2litre bottles with frozen water stored in the freezer to put in the coolers?

	|_|
	Do we have a thermometer to check the temperature of our food?
	|_|
	Do we keep our vehicle gas tanks full of gas?

	|_|
	Do we need to purchase a small generator?
	|_|
	Do we have plenty of spare batteries

	|_|
	Do we have an alternate way of heating the home?
	|_|
	Do we have an alternate way of cooking?

	|_|
	Do we have an alternate way of lighting the home?
	|_|
	Does everyone know the risks of Carbon Monoxide poisoning? 

	|_|
	Do we have an alternate way of charging our phones?
	|_|
	Does everyone know where the emergency release on the garage door is?

	|_|
	Do we have backup power for any special medical equipment in the home? 
	|_|
	Do we have a way to store water to flush the toilet in case the water supply is cut off?   (bath tub)

	|_|
	Do we have plenty of paper plates, plastic cups, plastic utensils so we don’t wash dishes?
	|_|
	Do we have plenty of “entertainment” on hand: board games, puzzles, books, etc. 

	|_|
	Do we have cash on hand in case the ATM’s don’t work?
	|_|
	     

	|_|
	     
	|_|
	     

	|_|
	     
	|_|
	     

	|_|
	     
	|_|
	     

	[bookmark: _Toc501024614]Terrorism Preparedness

	|_|
	Do we know where the school’s evacuation sites are and how we will pick up our children if activated?
	|_|
	Does everyone know the “Shelter in Place” procedures?

	|_|
	Do we have a room that we can seal off for “Shelter in Place” in case of a chemical leak/spill?
	|_|
	If the threat of Nuclear War is closer at hand, can we increase our Disaster Supply Kit to a 2-week supply quickly and easily?

	|_|
	     
	|_|
	     

	|_|
	     
	|_|
	     

	|_|
	     
	|_|
	     

	|_|
	     
	|_|
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[bookmark: _Toc501024615]Communication Plan
Used when the emergency or event initially happens.
Used when family is dispersed over a large area, more than 1 mile from home
1. Primary
a. Cell Phone
i. Voice: naturally the first choice of communication to give and receive the most accurate information with the most content
ii. Text: Text messages sometimes will go thru when voice calls will not due to overloaded network traffic. Almost as good as voice, but content suffers somewhat due to the fact that you are not having a normal conversation. Text messaging is more covert. 
2. Alternate
a. Use someone else’s phone to try to contact the person 
b. Use someone else’s phone that is on a different carrier. 
c. Try to contact another person. If that works, have that person try to contact the family member you are trying to contact and relay information.
d. Land Line telephones:
i. If cell towers are down, landline phones can be used. There are not many pay phones available now. Entering a business and asking permission to use their phone will work sometimes.  
3. Contingency
a. Out of state contact: If none of the above work, and there is an active widespread emergency (large tornado, large earthquake, terrorism, widespread power outage, etc.), you should contact the out of state contacts.
b. If all family members cannot contact each other, or one or more cannot be contacted, each one should call BOTH of the out of state contacts and let them know what is happening, their status and what they will be doing or where they are headed to. Then the out of state contact can let each family member know what is happening and relay any messages as the others call in. 
i. Primary out of state contact:        (name)
1. First try a voice phone call to       (phone number)
2. If voice doesn’t work, try text message. 
3. If the call goes thru but no answer, leave a message and then send a detailed text message.
ii. Secondary out of state contact:        (name)
1. First try a voice phone call to        (phone number)
2. If voice doesn’t work, try text message. 
3. If the call goes thru but no answer, leave a message and then send a detailed text message.
c.       (names of family, i.e. Dad and Mom) will contact the out of state contact on every half hour (1:30, 2:30, etc).
d.  The      (names of family, i.e. the kids) will contact the out of state contact on top of the hour (1:00, 2:00, etc) until we all get home. 
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Items to consider for Long Term Preparedness and Self Sufficiency
	|_|
	Chainsaw
	|_|
	Camp Coffee Pot

	|_|
	Cooking Grate (cook over an open fire)
	|_|
	Camp Shower

	|_|
	Dutch Oven
	|_|
	Camp Stove

	|_|
	Fire Starting Materials/Tinder
	|_|
	Canned food

	|_|
	Hand powered kitchen utensils
	|_|
	Charcoal, lighter fluid

	|_|
	Hatchet / Ax
	|_|
	Coleman Lanterns

	|_|
	Home Canned Food
	|_|
	Freeze Dried Food

	|_|
	Oil Lamps / Lamp Oil
	|_|
	FRS Two Way Radios

	|_|
	Self Defense Items 
	|_|
	Garden

	|_|
	Solar Power, Panels, Batteries, Charge Controllers
	|_|
	Small personal water filters

	|_|
	Water Purification Tablets
	|_|
	Rain Water Collection System

	|_|
	Wood Stove
	|_|
	Tent

	|_|
	Firewood
	|_|
	

	|_|
	
	|_|
	

	|_|
	
	|_|
	

	|_|
	
	|_|
	

	|_|
	
	|_|
	

	|_|
	
	|_|
	

	|_|
	
	|_|
	

	|_|
	
	|_|
	

	|_|
	
	|_|
	

	|_|
	
	|_|
	

	|_|
	
	|_|
	

	|_|
	
	|_|
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[bookmark: _Toc501024616]Back-Up Phone Database
List of important phone numbers in case the contacts in you phone is not accessible 
	Name
	Home Phone
	Cell Phone
	Email
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[bookmark: _Toc501024617]Completed Drills / Exercises (enter the dates when completed)
	Drill
	Date
	Date
	Date
	Date
	Date

	Fire / Unsafe Building Drill

	     
	     
	     
	     
	     

	Evacuation to a Long-Term Shelter Drill
	     
	     
	     
	     
	     

	Evacuation to a FEMA Safe Room Drill
	     
	     
	     
	     
	     

	Flood Evacuation Drill

	     
	     
	     
	     
	     

	Shelter in Place Tornado Drill

	     
	     
	     
	     
	     

	Shelter in Place Hazardous Materials Drill 
	     
	     
	     
	     
	     

	Communication Drill

	     
	     
	     
	     
	     

	     
	     
	     
	     
	     
	     

	     
	     
	     
	     
	     
	     

	     
	     
	     
	     
	     
	     


Each Drill should be practiced at least twice a year.
Schedule of Drills and Exercises
	January
	February
	March 
	April
	May
	June

	     

     
	     

     
	     

     
	     

     
	     

     
	     

     

	July
	August
	September
	October
	November
	December

	     

     
	     

     
	     

     
	     

     
	     

     
	     

     






[bookmark: _Toc501024618]Disaster Kit Maintenance
	Kit
	Date Updated
	Date Updated
	Date Updated
	Date Updated
	Date Updated

	Home Disaster Kit

	     
	     
	     
	     
	     

	Evacuation Kit

	     
	     
	     
	     
	     

	First Aid Kit

	     
	     
	     
	     
	     

	Pet Evacuation Kit

	     
	     
	     
	     
	     

	Vehicle Kit 1
     
	     
	     
	     
	     
	     

	Vehicle Kit 2
     
	     
	     
	     
	     
	     

	Vehicle Kit 3
     
	     
	     
	     
	     
	     

	Vehicle Kit 4
     
	     
	     
	     
	     
	     

	Informational Notebook
	     
	     
	     
	     
	     

	Medication Information
	     
	     
	     
	     
	     

	Family Medical Information
	     
	     
	     
	     
	     

	
	
	
	
	
	

	Smoke Detectors
	     
	     
	     
	     
	     

	Fire Extinguishers
	     
	     
	     
	     
	     

	Carbon Monoxide Detectors
	     
	     
	     
	     
	     

	Chimney / flue pipe inspected
	     
	     
	     
	     
	     

	Generator 
	     
	     
	     
	     
	     

	     
	     
	     
	     
	     
	     

	     
	     
	     
	     
	     
	     

	     
	     
	     
	     
	     
	     


Check / replace batteries, check for expired items, update information as needed, replenish used stock. 
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[bookmark: _Toc501024619]Editing Instructions, to add more form fields, more rows, etc the “Developer Tab” has to be showing. Most of the time, the “Developer Tab” on the menu is not visible. To make the “Developer Tab” visible:
· Click the File tab.
· Click Options.
· Click Customize Ribbon.
· Under Customize the Ribbon and under Main Tabs, select the Developer check box.
· “Unprotect” the document
· Click the “Developer Tab”
· Click “Restrict Editing”
· A panel will open on the right side, click “Stop Protection”
· If it asks for a password, all fields are blank.
· Make you edits and then click “Yes, Start Enforcing Protection” in the panel on the right.
· Do not type in “form fields” while in editing mode, it will erase the form field.
· Hit “OK”. 
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